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RULE 1: INTRODUCTION AND GENERAL PROVISIONS
The CFA Institute Research Challenge is a competition between university-sponsored teams that research a
designated publicly traded company, prepare a written report on that selected company, and then present their
findings to a panel of judges. The competition has three levels: local, regional, and global. Winners at the local
level advance to compete against teams within their geographic region at the regional level. Winning teams at
the regional level advance to compete at the global level. One team is designated the ultimate winning team, or
champion, at the global level.

1.1 Conflicts of Interest
All participants in the CFA Institute Research Challenge, including hosts, teams, team members, mentors,
faculty advisers, judges, and graders have an obligation to avoid actual or potential conflicts of interest with
their participation. A conflict of interest may exist when a participant or a participant’s family member or close
friend is involved in activities that may affect the participant’s ability to perform his or her role fairly and
impartially. Hosts, mentors, and advisers also have an obligation to avoid purposefully or inadvertently
pressuring teams to make a particular investment recommendation. A conflict may be actual or perceived. To
avoid any actual or perceived conflicts of interest, each participant must disclose to CFA Institute in writing any
potential conflicts, including but not limited to any ownership interest in the subject company and any close
personal or professional relationships with employees at the subject company.
Judges and graders must further disclose any close personal or professional relationship with team members,
mentors, or faculty advisers.

1.2 Plagiarism
Teams can read existing research on the subject company, but all analysis should be their own; they may not
copy analysis (i.e., plagiarize) from another source into their written reports or presentations. Sourced
information should be properly cited using a generally accepted citation system. Generally accepted citation
systems include, but are not limited to, the Chicago Manual of Style, the Harvard referencing system, and MLA
(Modern Language Association) style.
Teams found guilty of plagiarism will be disqualified and reported to the CFA Institute Professional Conduct
Program. The team’s university may also be ineligible to participate in the following year’s competition.

1.3 Use of Reports
CFA Institute shall own the copyright in all materials prepared by or for hosts, teams, industry mentors,
graders, judges, or faculty advisers in connection with the CFA Institute Research Challenge. The written
reports and presentations prepared for the challenge may not be used for any purpose other than participation
in the CFA Institute Research Challenge.
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RULE 2: TEAMS
2.1 Team Composition
Up to two teams may represent a university.1 Local hosts have the sole discretion to allow more than one
team. When a local host agrees to allow two teams, both teams must participate in the same local final.
a. Each university team may consist of undergraduate, graduate, or a combination of undergraduate and
graduate students.
b. A team must consist of no fewer than three2 and no more than five members.
c. There can be no alternates. If a team loses one of its members, that member can be replaced no later
than two weeks prior to the submission of the written report at the local level. If a team falls below three
registered members after this date, they will not be eligible to continue in the competition.

2.2 Team Member Requirements
Each team member must:
a. complete the official registration form on the CFA Institute Research Challenge website no later than
two weeks following the local level kickoff meeting (timely completion of the official registration entitles
students to be recognized participants by CFA Institute and ensures that winning teams members are
eligible to travel to regional and/or global levels);
b. accept the terms of the participation agreement upon registration;
c. agree to abide by the CFA Institute Code of Ethics and Standards of Professional Conduct;
d. be a currently enrolled college or university student in an undergraduate or graduate program at the
time of the local level kickoff meeting;3 and
e. be registered for at least a part-time course load, as defined by his or her university, at the time of the
local level kickoff meeting.

2.3 Ineligibility
An individual is ineligible to be a team member, if that individual:
a. has previously participated as a team member at any level of the CFA Institute Research Challenge on
any team that has submitted a written report at the local level;

1A

university is defined as a degree-granting institution that primarily delivers teaching to students in a traditional educational setting,
such as a classroom, as opposed to solely through electronic media. This includes universities that provide online learning in addition to
their classroom-based course offerings. The institution should hold educational accreditation by an accrediting agency recognized by
mainstream academia to operate as an accreditor or authorization by a government organization, whichever is the standard for the
country where the institution is located. CFA Institute may, at its sole discretion, grant exceptions to this rule on a case-by-case basis.
2If,

because of extenuating circumstances, such as travel visa denial or serious illness/injury, less than three members of a team are
able to attend one of the in-person events (local, regional, or global), that team will not be disqualified provided that there are still at
least three official members on the team. If a team member is formally dismissed from or voluntarily quits the team, and the remaining
team comprises less than three members, that team will no longer be eligible to participate in the competition.
3If

the team member has graduated at the time of the local, regional, or global final, the team member may still participate in the
competition.
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b. has been, or is, employed in a role whose primary duty involves fundamental company analysis at the
time of the local level kickoff meeting4—unless the team member qualifies as an intern5 and is
permitted to participate as a team member under local competition rules;
c. has been, or is, a CFA® charterholder; or
d. has been sanctioned by the CFA Institute Professional Conduct Program.

2.4 Research
Only team members may conduct research on the subject company for the purposes of the CFA Institute
Research Challenge. Teams may use only publicly available information in conducting their research.6
a. Teams may utilize their industry mentor and/or faculty adviser as resources but may not enlist the help
of any other professionals in conducting research specific to the subject company.
b. The written reports and presentations should be prepared from the perspective of an independent
research analyst.
c. Teams can read existing research on the subject company but all analysis should be their own; they
may not copy analysis (i.e., plagiarize) from another source into their written reports or presentations.7
Sourced information should be properly cited using a generally accepted citation system.8

2.5

Interaction with Subject Company

Teams may not have contact with subject company corporate executives for the purposes of the CFA Institute
Research Challenge other than during the informational session (described in the following text) and the one
permitted follow-up communication.

4

Fundamental company analysis is defined as the examination of publicly available information and the formulation of forecasts to
estimate the intrinsic value of an equity security. Examples include estimating an equity security’s value using company data, such as
earnings and sales forecasts, and risk estimates as well as industry and economic data, such as economic growth, inflation, and
interest rates.
5CFA

Institute defines an internship as real-world work experiences in which students fulfill short-term positions within a company
or organization in order to gain hands-on experience and develop career-specific skills. Internships may be paid or unpaid, with or
without academic credit, and are of varying lengths.
6Publicly

1.
2.
3.

available information includes:
information in company financial statements and press releases,
information in the media about the company and its competitors, and
information from data aggregators (e.g., Bloomberg, CapIQ, FactSet, etc.).

Publicly available information does not include:
1. information about the company that is (or should be) known only to staff or some staff employed by the company or firms with
whom the company does business, and
2. information that is (or should be) known only to those involved in legal or regulatory proceedings involved with the company.
7Volunteer

charterholders who mentor or advise students must request and receive permission from their firm to share reports prepared
either within their firm or from outside sources. Additionally, all volunteers who work with students should ensure that they understand
how to avoid plagiarism and what is required when citing the work of another research analyst.
8Generally

accepted citation systems include, but are not limited to, the Chicago Manual of Style, the Harvard referencing system, and

MLA style.
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a. The subject company may provide teams with an informational session. The informational session may
include a question and answer (Q&A) session during which time teams may pose questions to the
subject company and the subject company may respond.
b. Teams may send one follow-up email to the subject company. When contacting the subject company,
each team must confine their contact to those corporate officers who normally interact with investors,
such as investor relations officers, CEOs, or chief financial officers.
c. Teams may not contact subject company corporate executives for the purposes of the CFA Institute
Research Challenge other than the informational session, the Q&A session, and the one permitted
follow-up communication.
d. Teams are permitted to interact with the company as a member of the general public (e.g., teams may
dine in a restaurant that is a subject company or take a tour of the subject company if it is publicly
available).
e. Teams may contact the subject company’s customers, competitors, former employees, and suppliers in
conducting research, including surveys; however, each team member must identify him/herself as a
student and disclose his/her participation in the CFA Institute Research Challenge.
f. Prior to contacting the subject company, its customers, competitors, former employees, or suppliers,
the team must submit its questions to the faculty adviser or industry mentor. The faculty adviser or
industry mentor must participate in each communication but only for the purpose of ensuring that no
material nonpublic information is discussed. Faculty advisers and industry mentors are not permitted to
ask any questions or provide any opinions on the subject company. The time spent by the faculty
adviser or industry mentor while monitoring this kind of communication will not count toward the
maximum number of hours allotted for faculty adviser or industry mentor involvement.

2.6 Written Reports
Each team must prepare a written research report on the subject company. Teams may utilize their industry
mentor or faculty adviser as a resource but may not enlist the help of any other professionals in writing the
actual report.
The written report must:
a. conform to the guidelines set forth in Appendix A, “Written Report Guidelines” (the cover pages are
shown in Appendix B),
b. not exceed 10 A4-sized pages but may include an appendix no longer than 20 A4-sized pages,9
c. contain only publicly available information,
d. be the original work of the team members,
e. be prepared from the perspective of an independent research analyst, and
f. be submitted to the local level host by the deadline established by the host.10
The written report will be graded according to the criteria set forth in Appendix D, “Research Report Evaluation
Form.”

9Instructions

on how to change the paper size in Microsoft Word are available in Appendix C.

10

Hosts may impose penalties for late submissions. Penalties may include, but are not limited to, point deductions or disqualification
from the competition. The decision to impose penalties and the extent of those penalties is at the discretion of the host.
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2.7 Presentations
Each team may make a presentation of their findings to a panel of judges.
a. Teams may utilize their industry mentor and/or faculty adviser as a resource but may not enlist the help
of any other professionals in preparing content or evaluating the presentation, including conducting
practice presentations in front of one or more professionals (e.g., mock judging panels). Teams may
utilize presentation coaches or other public-speaking resources as long as those resources do not
contribute to the content of the presentation.
b. The students may not hand the judges any printed materials before or after the presentations, but the
local host should print out the presentation slides for each team and distribute to the judges before the
event.
c. Teams may not use props in their presentation.11
d. Logo use.
e. Only team members may participate in the presentation.
f. The presentation is limited to 10 minutes; however, an additional 10 minutes will be provided to answer
questions posed by the judges. Only judges are permitted to pose questions to a team during the Q&A
portion of a presentation.
g. Each presentation will be timed and the timekeeper will provide a one-minute warning and an
announcement when time has expired. When the timekeeper announces that time has expired, teams
must immediately conclude the presentation.
h. Presentations will be judged according to Appendix E, “Presentation Scoring Sheet.”

RULE 3: FACULTY ADVISERS, INDUSTRY MENTORS, JUDGES, AND GRADERS
3.1 Faculty Advisers
a. Each team may be provided one faculty adviser. The faculty adviser must be currently employed as a
faculty member by the team’s sponsoring university.
b. The faculty adviser will be selected by the team’s university.
c. The faculty adviser’s primary responsibility is to provide guidance and direction to the team throughout
all levels of competition.
d. The faculty adviser may not contribute any research or content to either the written report or the
presentation.

3.2 Time Permitted with Faculty Advisers
Teams are permitted to use a faculty adviser on substantive matters for limited hours. Teams may spend up to
10 hours with the faculty adviser prior to submitting the written report. For each local, regional, or global final in
which the team competes, the faculty adviser may contribute an additional three hours. Logistical work, such
as arranging meeting space and times and class attendance, does not count toward the time limit.

3.3 Industry Mentors
Each team will be provided one industry mentor.

11A

prop is defined as an object used by students to enhance or illustrate an aspect of the team presentation.
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a. The industry mentor will be selected by the local level host.
b. The industry mentor may review the team’s written report but may only provide comments.
c. The industry mentor may not contribute any research or content to either the written report or
presentation.
d. Students may not receive assistance from additional finance industry professionals.
e. It is recommended that industry mentors be CFA charterholders.

3.4 Time Permitted with Industry Mentors
Teams are permitted to use an industry mentor on substantive matters for limited hours. Teams may spend up
to six hours with the industry mentor prior to submitting the written report. For each local, regional, or global
final in which the team competes, the industry mentor may contribute an additional two hours. Logistical work,
such as arranging meeting space and time, does not count toward the time limit.

3.5 Judges and Graders
Judges
a. Judges will evaluate each presentation using the presentation scoring sheet (see Appendix E).
b. Each local level competition must have a minimum of three judges per panel.
c. The judges will be selected by the event host. All judges must be investment professionals. It is
recommended they have experience writing and reviewing equity research reports.
d. It is recommended that judges be CFA charterholders.
Graders
a. Graders will evaluate each written report using the Research Report Evaluation Form (see Appendix
D).
b. Graders will be selected by the event host.
c. All graders must be investment professionals with experience in writing and reviewing research reports.
d. It is recommended that graders be CFA charterholders.

RULE 4: LOCAL LEVEL COMPETITION
4.1 Eligibility of Host
Only CFA Institute, CFA Institute member societies, and CFA Institute–approved entities are eligible to serve
as local level hosts.

4.2 Competition Requirements
Local level competitions must have at least three universities, as defined in Rule 2.1, committed to participating
by the specified competition start date. If fewer than three universities commit to participating by the
competition start date in a local level competition, the winning team in that local final will not be eligible to
compete at the regional level. If universities drop out of the competition after the competition start date, the
winning team in that local final will be eligible to compete at the regional level even if there are fewer than three
universities at the end of the local competition.
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Universities participating at the local level must be physically located within the natural geographic region of
that university’s local host.12
The winner from each eligible local level competition (as previously defined) will advance to a regional level
competition. If the local level competition has at least 24 universities competing, then the top 2 universities will
advance to a regional level competition. Only the first-place finisher in local level competitions involving 23
participating universities or fewer will advance to the regional competition.
Local level competitions must adhere to one of the following competition formats:
 Classic format. The classic format is used when all participating teams present at the local final
competition. Typically, these competitions feature three to six teams. Each team submits a written
report and gives a presentation to a panel of judges. The winning team will have the highest combined
score based on the written report results (50%) and the presentation results (50%).
 Staggered format. The staggered format is used when it is not feasible for all teams to present at the
local final, so the scores from the written report and/or the presentation allow only the top teams to
advance. Typically, these competitions feature more than six teams and follow two options:



o

Staggered Format A: Each team submits and is evaluated on a written report. The teams (at
least three) with the highest written report scores advance to give a presentation to a panel of
judges. If all teams are evaluated by the same graders, the winning team will have the highest
combined score based on the written report results (50%) and the presentation results (50%). If
the teams are evaluated by different sets of graders, the winning team will be the team with the
highest presentation results.

o

Staggered Format B: Teams are divided into at least two semifinal groups. Each team submits a
written report and gives a presentation. Teams are evaluated among their groups, and the top
teams based on the combined score of the written report (50%) and the presentations (50%)
advance to the local final. The winning team will then be determined in the local final based
solely on the presentation scores.

District format. The district format is used in a large geographic area when travel to and from a central
location is not possible. These competitions are allowed only under special circumstances and need to
be approved by CFA Institute. Teams are assigned to one of at least four districts. There must be at
least four teams in each district. Each team submits a written report and gives a presentation to the
district’s panel of judges. Each district will send the team with the highest score in that district to the
local final. The winning district teams will compete against one another at the local final to determine
the winning team.

In the event of a tie in presentation scores at the local final, the winner will be determined in the following order:
a. The team receiving the higher overall score for the presentation will advance.
b. If there is still a tie in the overall score for the presentation, the team receiving the higher score in the
financial, valuation, and other analysis section of the presentation is deemed the winner.

12Societies

may submit requests for an exception to this rule; these requests will be evaluated by CFA Institute.
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c. If there is still a tie between the overall score for the presentation and the financial, valuation, and other
analysis section, the team receiving the higher score in the questions section of the presentation is
deemed the winner.
d. If there is still a tie among the overall score for the presentation; the financial, valuation, and other
analysis section; and the questions section of the presentation, the team receiving the higher score in
the argument section will be deemed the winner.
e. If there is still a tie among the overall score for the presentation; the financial, valuation, and other
analysis section; the questions section; and the argument section of the presentation, the team
receiving the higher score in the team involvement section will be deemed the winner.

4.3 Host Requirements
Local level hosts must do the following.
a. Sign and submit the CFA Institute Research Challenge Host Agreement by 17 August 2016.
b. Select the subject company in accordance with the following rules:
i.
The subject company must be publicly traded.
ii.
The subject company can only work with one local competition (no local level research
challenge competitions may share the same subject company).
iii.
The subject company must be in the host's natural geographic area unless otherwise approved
by CFA Institute.
c. Select the industry mentors, graders, and judges.
d. Ensure that all team members meet the eligibility requirements set forth in Section 2.2.
e. Ensure that no team members are ineligible pursuant to Section 2.3.
f. Send the result of the local level and the winning team’s written report to CFA Institute within two days
of completion of the local final.

4.4 Travel and Accommodations
Participants and volunteers are responsible for any and all expenses incurred for travel and accommodations
related to the local level competition unless otherwise specified by the local host.

RULE 5: REGIONAL AND GLOBAL LEVEL COMPETITIONS
5.1 Regional Level Host
CFA Institute will act as the host for the Asia Pacific; Europe, Middle East, and Africa; Americas regional; and
global level competitions.

5.2 Travel and Accommodations
a. CFA Institute will cover travel and accommodation costs for the winning team of each eligible local level
competition (as defined in Rule 4) and one sponsored guest.13 The sponsored guest will be determined
by the winning team.

13

Limited to a faculty adviser, industry mentor, or CFA Institute Research Challenge host representative.
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b. All students and sponsored guests must book their travel to and from the event using the official CFA
Institute travel management company, FCm Travel Solutions. Reservations made through agencies
other than FCm Travel Solutions will not be eligible for reimbursement.
c. CFA Institute will cover roundtrip economy airfare. CFA Institute covers only the lowest-cost roundtrip
option that takes travelers from their departure city to the competition location and back. If travelers
decide to extend their stay, choose different layovers, etc., CFA Institute will pay only for the lowestcost roundtrip option. Extra costs will be incurred by the traveler.
d. All travelers must book travel by the deadline specified by CFA Institute. If travelers book later than this
date, CFA Institute will cover only what the cost the flight would have been by the deadline. Extra costs
will be incurred by the traveler.
e. CFA Institute will not pay for taxis, rental cars, visa application fees, food and beverage (not provided at
a CFA Institute–sponsored function), baggage fees, and any other fees or expenses not specifically
mentioned previously.
f. All travel arrangements for which CFA Institute will pay must be made through a CFA Institute–
approved travel agency, and payment will be remitted directly to the agency, not to any participant.
g. CFA Institute will arrange hotel rooms for the winning team of each eligible local level competition (as
defined in Rule 4) and one sponsored guest.
h. Students will room with one other student. Roommates will be assigned by CFA Institute according to
university affiliation and gender. Students may be assigned to room with a student from another
university.
i. Students may make alternative flight and lodging arrangements at their own expense.

5.3 Competition and Scoring
The winning team from each regional competition will advance to the global final. If the regional level
competition has at least 36 universities competing, then the top two universities will advance to a global level
competition.
Local hosts will submit the winning team’s research report for the regional competition. The research report will
be the same one that was evaluated locally. No changes can be made.
Teams must submit their presentations in the specified version of Microsoft PowerPoint. CFA Institute will
announce the supported version of Microsoft PowerPoint in advance of each regional competition. CFA
Institute cannot guarantee technical support for presentations submitted in any other format.
During the first round of each regional competition (quarterfinal or semifinal round), the overall score will be
based on 50% written report score and 50% presentation score. CFA Institute will send the written report from
each team to a group of regional graders. These graders will score reports for the teams competing against
each other in that first round (e.g., the reports for each team in Room 1 will be scored by one group of graders,
the reports for each team in Room 2 will be scored by another group of graders, and so on).
The overall score for each subsequent round of competition will be based 100% on the presentation as set
forth by Rule 2.6. Regional judges will assess the presentation score using Appendix E.
11

In the event of a tie between scores during any of the regional or global competition rounds, the winner will be
determined in the following order:
a. The team receiving the higher overall score for the presentation will advance (only applicable during the
first round of a regional competition).
b. If there is still a tie in the overall score for the presentation, the team receiving the higher score in the
financial, valuation, and other analysis section of the presentation is deemed the winner.
c. If there is still a tie between the overall score for the presentation and the financial, valuation, and other
analysis section, the team receiving the higher score in the questions section of the presentation is
deemed the winner.
d. If there is still a tie among the overall score for the presentation; the financial, valuation, and other
analysis section; and the questions section of the presentation, the team receiving the higher score in
the argument section will be deemed the winner.
e. If there is still a tie among the overall score for the presentation; the financial, valuation, and other
analysis section; the questions section; and the argument section of the presentation, the team
receiving the higher score in the team involvement section will be deemed the winner.
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Appendix A – Written Report Guidelines
Each team must prepare a written research report on the subject company chosen by the local host. Teams may use their
industry mentor or faculty adviser as resources but may not enlist the help of any other professionals in writing the actual
report.
The written report must
 be no longer than 10 pages (not including the front and back covers provided by CFA Institute) on A4-sized
paper* (210 mm × 297 mm, 8.27” × 11.69”), although you may include an appendix of infinite length;
 include the following information in a header on the first page:
o Company name
o Exchange
o Ticker symbol
o Sector
o Industry
o Recommendation (buy/sell/hold)
o Current price (as of __ date)
o Target price (% increase/decrease)
 contain only publicly available information;
 be the original work of the team members;
 be prepared from the perspective of an independent research analyst;
 be submitted to the local-level host by the deadline established by the host;
 include the front and back covers provided by CFA Institute with the information in highlighted text filled in (teams
must not alter any other part of the cover pages, including the CFA Institute logo); the back cover should be
placed after the appendix; and
 contain (but not limited to**) the following sections:
o Business description
o Industry overview and competitive positioning
o Investment summary
o Valuation
o Financial analysis
o Investment risks
o Corporate governance
*If you would like to print an A4-sized document to letter-sized paper, you can select the option to automatically resize the
document in your printing options by selecting Page Layout > Page Setup > Print Options > Advanced. Ensure that “Scale
content for A4 or 8.5 x 11” paper sizes” is selected:

**You may also include other headings for important information not otherwise covered in the previously listed sections.
The reports will be graded based on the scoring rubric in Appendix D. Take note of the comments section, which presents
reasons why points may be deducted from each section.
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Appendix B – Written Report Cover Pages

CFA Institute Research Challenge
hosted by/in

Local Challenge (e.g., CFA Society Virginia, Vietnam, etc.)
Team Name
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Disclosures:
Ownership and material conflicts of interest
The author(s), or a member of their household, of this report [holds/does not hold] a financial interest in the securities of this company.
The author(s), or a member of their household, of this report [knows/does not know] of the existence of any conflicts of interest that might bias
the content or publication of this report. [The conflict of interest is…]
Receipt of compensation
Compensation of the author(s) of this report is not based on investment banking revenue.
Position as an officer or a director
The author(s), or a member of their household, does not serve as an officer, director, or advisory board member of the subject company.
Market making
The author(s) does not act as a market maker in the subject company’s securities.
Disclaimer
The information set forth herein has been obtained or derived from sources generally available to the public and believed by the author(s) to be
reliable, but the author(s) does not make any representation or warranty, express or implied, as to its accuracy or completeness. The information
is not intended to be used as the basis of any investment decisions by any person or entity. This information does not constitute investment
advice, nor is it an offer or a solicitation of an offer to buy or sell any security. This report should not be considered to be a recommendation by
any individual affiliated with [society name], CFA Institute, or the CFA Institute Research Challenge with regard to this company’s stock.

CFA Institute Research Challenge
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Appendix C – How to Change Paper Size to A4
For Microsoft Word 2007/2010:
 Open Microsoft Word.
 Click on the “Page Layout” ribbon.
 Click “Size.”
 Scroll until you find “A4.”
 Select A4.
 Watch a step-by-step video here.

For Microsoft Word 2003:
 On the File menu, click Page Setup, and then click the Paper tab.
 Select A4.
 See the Microsoft website for more information.
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Appendix D – Research Report Evaluation Form

www.cfainstitute.org/researchchallenge

Research Report Evaluation Form
Maximum
Points

Section

Business Description

5

Industry Overview &
Competitive Positioning

15

Investment Summary

20

Valuation

20

Financial Analysis

20

Investment Risks

15

Corporate Governance

5

Total

Comments

100
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Appendix E – Presentation Scoring Sheet

www.cfainstitute.org/researchchallenge
CFA Institute Research Challenge
Presentation Scoring Sheet

Team:

Criteria

Judge:

Maximum
Points

Points

Financial Analysis
How thorough was their
analysis of the industry,
company, and
competitors?

25

Valuation
Were the valuation
methodologies appropriate
and detailed?

25

Presentation
How effective/convincing
was their presentation?
Was it logical and did the
facts support the
recommendation?

20

Question & Answer
Were they able to answer
the questions effectively
and with confidence?

20

Team Involvement
Team involvement in the
presentation/questions and
answers

Materials
Quality of slides

5

5

18

Notes

Total

100
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